
Application

Using the ChemStore data 
management module in a ChemStation
Plus networked data system to generate
sophisticated analysis reports

Abstract

The Agilent ChemStation base software includes a wide range of built-in

report styles and types. For example, it provides standard reports such

as area percent (AREA%), external standard (ESTD), internal standard

(ISTD), and normalized (NORM) reports as well as system suitability

reports and sequence summary reports with statistical evaluation of

retention times, areas, heights and more. These standard reports are 

the topic of a further Application Note1. More sophisticated reporting 

is possible using ChemStore, an add-on software module for the

ChemStation base software, thereby creating a ChemStation Plus 

networked data system. This data storage and management module not

only provides for powerful reporting but also offers cross-sample,

cross-instrument result review, and second-pass analysis. This application

Note describes the reporting capabilities of ChemStore

Angelika Gratzfeld-Huesgen



2

Introduction
Using the add-on ChemStore data
storage and management module
in a ChemStation Plus networked
data system provides the user
with database functionality.
Whereas the ChemStation base
software enables instrument 
control, data acquisition and
analysis, basic reporting and 
first-pass review, ChemStore 
provides maximum data protection
and integrity for
• organization and management

of data in studies
• second-pass review and

approval of results
• generation of customized

reports
• storage of all related results, 

raw and meta data in a 
relational database

• archive and retrieval of data 

Before starting with ChemStore
reporting, the chromatographic
methods, which include integration
and calibration parameters, must
be set up and tested. For full
traceability and change control, 
all data analysis and re-analysis is
done using the ChemStation base
software, whereas ChemStore
database acts as a data and result
management, and review and
reporting tool. ChemStore does
not allow the user to change inte-
gration or calibration parameters –
these changes must be done using
the Data Analysis part of the
ChemStation. This separation of
functionality between the two soft-
ware modules provides both users
and auditors with an easy distinc-
tion between the tasks of reanalysis
and review, thereby maintaining
data integrity and capturing all
changes in audit trails.

The following sections provide a
step-by-step guide for generating
ChemStore reports.

Setting up ChemStation 
parameters at sample entry
before analysis execution
Before you send data to the data-
base, we recommended doing the
following steps.

1 Set up the chromatographic
method as well as the integration
and calibration tables1.

2 Set up the ChemStation sequence
table, including correct entries
for the sample type, number of
injections, and so on1.

3 Set the ChemStation report 
type appropriately. Only those
results that are processed in 
the ChemStation report are
transferred automatically 
to the database. For example, 
if you want to generate a system
suitability report with ChemStore,
you must select the report type
Extended Performance in the
ChemStation1. In the example
described in this note only a
subset of this data, including
tailing factors and theortical
plates, is used to calculate the
ChemStore system suitability
report, which is a built-in report
template. These calculations
might only be required for the
system suitability samples, for
examples, at the beginning of
the sequence. Therefore it may 
be necessary to set up different
methods – containing different
report types – for samples, 
calibration standards and control
samples. This will depend on the
indiviual reporting requirements.

Note that the amount of result
data transferred to the database 
is dependent on the report style
selected in the ChemStation 
chromatographic/evaluation
method, the *.M file.    

Setting up ChemStore 
Set up a study in the ChemStore
review client by choosing Create

Study from the Administration

menu, and define storage 
conditions, users who should 
have access to this study, and if
required, custom field values.
When you have set up a study, go
to the ChemStation Method and

Run Control screen and choose
Sequence Setup from the
ChemStore menu, see figure 1.

1 Click Transfer Settings to 
configure the data transfer,
report style and destination.
This example transfers data
after each analysis and uses an
existing built-in report template
Compound Amounts Report ,
which is printed at the end of
the sequence.

2 Click Select Study to select the
study destination for data and
results from a list of all available
studies.

3 Click Custom Field Values

to set data entry into optional 
custom fields.

When you have set these
ChemStation and ChemStore
sequence parameters, you can
start the ChemStation sequence.
Data and results are transferred
automatically to the selected
study into the database. At the end
of the sequence the ChemStore
report is printed using the selected
report template.



Figure 1
Set up of data transfer and reporting in ChemStore, showing the selected study and the selection
of report format and out put 
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ChemStore reporting tools
ChemStore has three reporting
tools; print actual window,
advanced comprehensive reports
using built-in report templates,
and custom reports.

Print actual window
Printing of the actual window is
quick and easy and is done from
the main menu. The full content 
of the window is printed on a
maximum of two pages – one 
page for tabular results and one
page for charts or chromatograms.
This printing tool offers a quick
snapshot paper copy of your 
current data set. This can include
the trend chart visualization of
your results,  demonstrating a
drop in resolution of your column
and initializing a column change,
for example.

This functionality also allows you
to export easily the contents of
the actual window – tabular results
can be exported to Microsoft Excel
and graphics can be copied to the
clipboard.

Advanced comprehensive reports
using built-in report templates
• Instrument and run report 

with chromatograms, tables 
and charts

• Sample summary report
• Compound summary report
• Peak details report
• Kinetics report
• System suitability report

Custom reports
Custom reports enable combina-
tions of any ChemStore data,
including statistics, audit informa-
tion, cross-sample trend charts,
and sample or compound details
in one comprehensive report.
Custom reports are created either
by modifying a built-in template or
by starting from scratch.
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Report setup and configuration
ChemStore always creates reports
based on a given set of data. This
data set is either defined through
the ChemStation sequence, when
the ChemStore report is generated
at the end of data acquisition, or it
is defined through the database
query.

Selection of data files for reporting –
querying the database
We recommend using data files
from an existing study and to
modify and create templates using
this data set. To start a report first
a query must be created. This is
done on the ChemStore Review
Client by choosing Create Query
from the File menu. Creating a
query can also be done using the
appropriate icon, see figure 2.
Clicking the query icon displays
the Query Builder. Different
selection criteria can be chosen
and easily combined to narrow
down the query output to the
desired data set, for example,
based on the study name, on
sequence file names, on raw data
file names such as shown here, on
injection volumes, or on acquisition
date, and many more. When you
have selected the criteria for the
query, you retrieve the data by
simply clicking Retrieve in the
Query Builder. 

Selecting the overview window
The ChemStore user interface 
is divided into task-oriented views, 
as shown in figure 3. The views
display either tabular result 
data or graphical data such as
chromatograms and spectra or
customizable trend charts. 

Figure 2
Building a query
1. Create a query
2. Select data files
3. Retrieve data files
4. Start report selection and editing

Figure 3
The ChemStore user interface, in which the graphical sections display the chromatogram and
spectrum of the highlighted compound
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Note that each view has an 
individual table configuration,
thereby requiring the user to repeat
the table setup for each view under
consideration. Once configured,
all tables can be saved for later
reuse with the Save User Interface

command. Each user logging on to

ChemStore will find their individual
user interface configuration. It is
saved with the user's logon details
and displays on any client as soon
as the user logs on to the database.
Once a user interface has been
designed and saved, it can be
assigned easily to any other user.

ChemStore allows the user 
to define the interface to suit 
individual requirements. Each
user can define their own inter-
face in terms of data display, 
statistical results, and size and
separation of the display.
ChemStore has three predefined
views.
• Sample-based information and

results or individual compound
results can be chosen for review
using the tabs shown in figure 4.

• Results overview with 
chromatogram and spectra,
results table or trend charts 
can be selected using the icons
as shown in figure 5

• Additional statistical result 
calculations for summary and
regression statistics are available
for result tables.

Configuring the results table
ChemStore displays two tables
(see figure 3):
• The table at the left side of 

the overview window is not
configurable because it displays
the list of runs or compounds
that were retrieved by the
query. For the sample view 
this list includes the actual run
number, approval and archive
status, and the current result
version. In the compounds view
the list includes all compounds
according to the ChemStation
calibration. 

• The other table is the result table.
This table must be configured
using either the icon or by
choosing Columns-Define from
the Options menu as shown in
figure 6.

Figure 4
Sample and Compound tabs

Figure 5
Sub-views for result overview, tabular results and trend charts

Figure 6
Defining columns through the menu bar or smart ion



The result table is configured 
similar to the query builder. 
The user selects the result data
from a list of all available results.
In addition, each table column 
can be formatted individually 
as shown in figure 7. Additional
calculations on each column 
can be configured using the
Expression button. This allows,
for example, to calculate relative
retention times based on one 
reference.

When the interface has been 
configured, the user can select
Print View to get an immediate
printout of the contents of the
actual window. For advanced
reports, the user can set up 
custom reports tailored to their 
individual needs.

Report setup
Using built-in report templates
ChemStore uses a runtime version
of Microsoft Access to generate
reports. This offers access 
to the powerful tools of database
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reporting. However it also adds
some complexity to the report
configuration compared to
ChemStation reporting.
ChemStore therefore includes a
set of built-in report templates
that are ready to use and do not
require any interaction with the
report generator. The user simply
selects the report template from a
list of available templates and
starts reporting (see figure 8) by
sending the data either to a file or
to the printer. 

Setting up custom reports – Report
template generation step by step
After loading the data files, the
user can print the results using the
print functions as described in
previous sections. Alternatively,
the modification of an existing
template or creation of a new 
template can begin. 

Step 1: Definition and layout of a new
report template
If the user is not familiar with
report editors, we recommend
starting with modifying an existing

report template, for example, the
built-in Compound Amounts

Report template. A good strategy
is the following:

1 Let data be evaluated by 
one or several existing report
templates.

2 Note the required modifications
(this might include modification
of the ChemStation report type,
to provide the results needed for
the selected ChemStore report)

3 Classify the modifications as:
• another column to an existing

table
• different selection criteria for

an existing table or chart
• different setup for the x

and/or y-axis of charts
• a new table
• a new chart

This procedure can be repeated
for several existing report 
templates. Elements from different
report templates can be combined
and saved as a new customized
template.

Figure 7
Result tables setup, table column formatting and definition of expressions for custom calculations
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Step 2: Analyze actual report from a
built-in report template
Data-file retrieval, as described in
an earlier section, is required
before you can start managing,
creating and editing reports. Let’s

assume that you want to select 
the report template Compound

Amounts Report from the existing
report templates (see figure 8). 
In this example the data from 
the study Quality Control is used.

Having selected this report 
template, report generation and
print out of the report is done by
clicking the print icon.

Figure 8
Selection of report template for printing, showing the print icon and the built-in reports (including two user-created report templates at the end
of the list)



Report examples
Figure 9 shows the first page 
of the report, which contains a
total of seven pages for the three
analyzed compounds. Only the
results obtained for antipyrine are
shown. The first page contains the
header and the selection criteria
that were used in the query. In
this case the raw data file names
were the selection criteria.
Further selection criteria were

8

Compound Amounts Report

Report Last Modified: 20-Jan-00 13:08 Current agratz

Data Selection Criteria

Query

Name: <untitled> (agratz)
Run Selection: Only latest runs
Conditions: Raw Data.Data File IN (´NEW00031.D´, ´NEW00032.D´, ´NEW00033.D´, 

´NEW00034.D´, ´NEW00035.D´, ´NEW00036.D´, ´NEW00037.D´, 
´NEW00038.D´, ´NEW00039.D´, ´NEW00040.D´) AND

Reprocessing Status: All

User Filter

Condition: None

Template

Compounds: Only calibrated compounds:

Page 1 of 7

that only results for calibrated
compounds should be printed. 
No other filters or further criteria
were used.

On the next report page, the
results for antipyrine are printed
as a compound table, see figure
10. This type of table contains
information about the study name,
the chromatographic method
used, the compound name and the

table with calculated qualitative
and quantitative data for
antipyrine. The table comprises
seven columns that contain run
number, sample name, data file
name, retention time, peak area,
peak height and amount. For 
the peak time, area, height and
calculated amount the precision 
is calculated and printed at the
bottom of the corresponding 
column. 

Figure 9 
First page of compound amounts report, showing query and compound selection criteria



A compound chart is included on
the second page, see figure 11.
Here, the amount is plotted
against run number and the mean
value, the upper and lower warn-
ing limits and the upper and lower
critical limits are drawn. The user
can define these values.
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Compound Amounts Report
Study Name: test Instrument Name: Instrument 1
DA-Method: C:\HPCHEM\1\METHODS\LINI22.M
Compound Name:Antipyrine

Run No. Sample Data File Peak Time Peak Area Peak Height Calc. Amount

Data Path: C:\HPCHEM\1\DATA\NEWLIN\
2 <unknown> NEW00032.D 2.074 72.280 17.981 39.47
3 <unknown> NEW00033.D 2.075 68.471 17.050 37.48
4 <unknown> NEW00034.D 2.075 68.568 17.082 37.53
5 <unknown> NEW00035.D 2.074 68.872 17.145 37.69
6 <unknown> NEW00036.D 2.074 71.200 17.729 38.91
7 <unknown> NEW00037.D 2.075 67.894 16.916 37.18
8 <unknown> NEW00038.D 2.075 68.090 16.981 37.28
9 <unknown> NEW00039.D 2.075 70.836 17.656 38.72
10 <unknown> NEW00040.D 2.074 69.777 17.379 38.17

Mean 2.074 69.554 17.324 38.05
Std. Dev. 0.00051 1.55488 0.38065 0.8131
RSD 0.02 2.24 2.20 2.14
Overall Mean 2.074 69.554 17.324 38.05
Overall Std. Dev. 0.00051 1.55488 0.38065 0.8131
Overall %RSD 0.02 2.24 2.20 2.14

Figure 10
Second page of compound amounts report, showing compound Table with selected header, qualitative and quantitative data and statistics

Figure 11
Chart of amount antipyrine per run in compound amounts report, showing mean value, upper and
lower warning limits, and upper and lower critical limits
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Step 3: Modifying an existing 
element in a built-in report to 
generate a custom report
If you want to change the limits
for the compound chart, click the
report icon again and select Edit.
To display the Report Editor, see
figure 4. The report template for
the Compound Amounts Report is
started as shown in figure 12. 
The report elements are shown at
the left side. If a report element is
highlighted, the context-related
menu for editing and changing this
element appears at the right of the
screen. 

To change the limit settings 
for a chart, highlight the item
Compound Chart under Data

Section. Choose Options to 
display the menu for limit settings,
see figure 13.

Here you can change the expected
mean value and the limit settings.
In the example, the mean value
was set to 38 ng and the upper
and lower warning level to 1σ
deviation from the mean value.
The upper and lower critical limit
was set to 2σ deviation from the
mean value. Instead of using a
specified value for the center line,
the calculated mean value can be
selected. Having changed the 
parameters, the report template can
be saved under a new name and
can be used for further reporting.

Figure 12
Report Template Editor, showing the template for the compound amounts report – if a report 
element is highlighted, the appropriate menu for editing and changing parameters for this 
element appears. Use the Options button to display the menu for limit settings.

Figure 13
Setting chart parameters – the mean value is specified to be 38 ng, the upper and lower warning
level is set to 1% deviation from the mean value, and the upper and lower critical level is set to
2σ deviation from mean value
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Step 4: Adding a new data element 
to an existing template Adding a run
table
If a built-in report template does
not contain the information needed,
a new report element must be
added. Select the report section
for the addition of the element.
Choose Insert Data Element from
the Edit menu, see figure 14. 
A section header, chart, table,
chromatogram and spectrum,
print out of selection criteria, and
a page break can be inserted. In
this example the insertion of a
table was selected.

Several different table types can
be added, see figure 15, related 
to the injection, run, signal, 
compound, peak, column con-
figuration, instrument components
or audit trial. This example
explains in more detail how to
setup a run table. 

Figure 14
Inserting data elements such as tables and charts

Figure 15
Adding a table – by selecting Run, a result table can be created that contains information related
to each run



Figure 16
Set up of run table, showing default columns in a run table and addition of a column using the
Columns button

Figure 17
Sample Type has been added as a new column in the run table

All tables contain default columns
that are shown at the top of the
run table menu, see figure 16). To
add or to remove columns, click
Column.

In figure 17, Sample Type has
been selected as an additional 
column. Adding and removing
columns is done using the 
arrows in the center of the menu.
Choosing OK confirms the change,
which is applied to further 
reports. The column order can be
rearranged using the arrow buttons.

Step 5: Using logical elements such
as grouping or restrictions to generate
statistics and overview information
It is often required to reorganize
result data in multiple ways,
according to both chronological
criteria (such as list of injections)
and logical criteria (such as sample
type, user name, and so on)
instead of a pure sequence-based
organization of results. ChemStore
provides the following tools to
organize data logically.
• Restrictions
• Grouping
• Summaries (for statistics)
• Compound-based filtering of

reports

The following examples show how
these parameters influence
results.

Restrictions
An example task would be to 
create a table with default 
compound table columns, listing
only those samples that contain
the compound Antipyrine and
thereby avoiding empty and 
nonsensical lines. Statistical
results for all repetitive injections
of the same sample are required.
In ChemStore reporting terms, 
this means setting up a new 
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Figure 18
Compound table screen

Figure 19
Restriction of table content so that the compound table only contains data for Antipyrine, when
the Amount is greater than zero and when the Sample Type is Sample

compound table, which should
contain the same columns as the
built-in Compound Amounts

Report. Statistical data should 
be calculated across files with 
the same injection volume and
only for compounds with 
amounts greater than zero and
where the sample type is Sample.
The Restriction, Grouping and
Summaries parameters need to 
be set up, see figure 18.

1 Add a new table to the report by
highlighting Data Section in the
report template and then choose
Insert New Data Element > Table

from the Edit menu and check
Compound Table.

2 Filter the compound data
according to the restriction 
criteria by clicking Restrictions,
which displays the screen shown
in figure 19. In this example 
the results should be restricted
to those runs that include the
target compound Antipyrine,
and standard or control runs
should be excluded. To restrict
the information on the compound
table, select Amount, Sample

type, and Compound name

from the available fields and 
add them to the right side as
base restictions. 

3 To each of these base restrictions,
data restriction must be added,
for example, the Amount should
be greater than zero. The Sample

type should always be Sample

and the Compound name should
always be Antipyrine. The effect
of these settings will be that 
the compound table will only
contain data for Antipyrine, if
the Amount is greater than zero
and if the Sample type is Sample.
Therefore, no calibration runs or
control samples will be included.
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Grouping
In the Grouping tool, criteria 
for the statistical evaluation of 
the compound table are set, see
figure 20. In this case, Volume

is selected from the available 
database fields. This means the
precision for retention times and
amounts will be calculated for
those runs with the same injection
volume.

Statistical summaries
In the Summaries tool the 
calculation procedure for the 
statistic can be selected. Several
calculation procedures are 
available such as mean value,
standard deviation and relative
standard deviation, see figure 21.
Statistical calculations can be
applied to all table data or more
granular on each group of data 
as set up with grouping.

Compound-based filtering of reports
So far the different selection tools
for charts and tables have been
described. ChemStore also includes
a high-level filter for compounds
that applies to all data sections
and allows users to select the
compounds to be included in the
report. ChemStore offers four
options:
• All compounds 
• All calibrated compounds
• Those specified at run time
• Specified compounds (manual

restriction to compounds 
of interest from a list of all
available compounds)

Figure 20
Grouping criteria for statistical evaluation –in this case statistical evaluation should be done
across those runs with the same injection volume

Figure 21
Selecting statistical calculation procedures, showing the available calculation procedures
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Figure 22
Restriction of complete report template on specific compounds, showing how the selection of
compounds for reporting can be done for the complete report template using the selected tool

Figure 23
Selecting well plate sampler parameters for printing using the pre-defined custom fields that are
available for the Agilent 1100 Series well-plate sampler

After highlighting the name of the
report template, see figure 18
where the template name is the
first item in the list on the left,
another selection tool can be used
to select only specific compounds
for reporting, see figure 22. This is
then valid for the complete report
template. The appropriate tool is
named Compounds and is at the
bottom of the screen.

Including information from the
Agilent 1100 Series well-plate 
sampler in the database
During setup of a sequence table
using the Agilent 1100 Series 
well-plate sampler, entries for 
the Plate id can be used to 
characterize the used well-plates.
These names or comments are
accessible through ChemStore
reports. Figure 23 shows how this
information can be selected in a
compound table for printing. 
Well-plate position, identification
and type are entered in the 
custom field section.
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In figure 24 an example of a 
compound table is shown, which 
– besides run number, name of the
compound, retention time and
amount – also contains information
about the well-plate location, 
identification and type.

These well-plate identification and
characterization tools can help to
keep track of compound libraries
relating to possible decomposition
over time or similar purposes. 

Managing report templates
Saving report templates
Report templates can be saved 
at any stage during report 
configuration, if the user has 
the right to Create/Edit report

templates. To save the report 
template, click Save and type 
a unique name in the field 
New report template name, see
figure 25. The left side displays all
report templates that were created
by the current user. 

Assigning report templates
Report templates are very important
in the daily laboratories’ work
because they present the analysis
result to supervisors, customers or

Library test report

Run No. Compound RT Amount Well-Plate Well-Plate Well-Plate 
ID Location Type

1 Beclomethasone 3.075 10.00 t405 D-12 *96Agilent*
1 Hydrocortisone 2.145 10.00 t405 D-12 *96Agilent*
1 Hydrocortisone 3.550 10.00 t405 D-12 *96Agilent*

-acetate
2 Phenobarbital 2.230 10.00 t405 A-08 *96Agilent*
3 Diazepam 4.291 10.00 p002 A-09 *384Agilent*
4 Phenacetin 2.357 100.00 p002 A-11 *384Agilent*
5 Antipyrine 1.642 100.00 p002 B-03 *384Agilent*
6 Doxycycline 1.658 50.00 p002 C-03 *384Agilent*

Figure 24
ChemStore report containing columns with Agilent 1100 Series well-plate sampler information

Figure 25
Saving report templates – This routine also allows modifying a built-in report template 
and saving the modified template as new report template

auditors. The template development
work is fairly intense because the
report design requirements are
quite often very complicated and
detailed based on pharmacopoeia
descriptions or other regulatory
guidelines. It is therefore important
to avoid unauthorized access 
or modifications to the report 
templates. But it also is important

that all system users can use the
report templates to print their
final analysis report. This requires
restricting access to report 
modifications (by granting 
or denying the user privilege
Create/Edit report templates) 
but giving access to a broader
group of instrument users to
report printing.



17

Figure 26
Assigning report templates to users

Figure 27
Assigning report template to user operator

ChemStore addresses this 
requirement by assigning report
templates to dedicated users. 
This configuration enables to
select and print reports based 
on custom report templates by
denying access to report template
modifications. The assignment of
report templates to certain users
also allows following the users
work practices. For example, 
if user group A is working on 
stability studies, their lab manager
will assign them access to their
stability reports with trend charts
but deny access to the routine
quality control reports of user group
B, who use the same instruments
as user group A.

For example, to assign the recently
created report template Compound

Amounts Report user1 to the
built-in user named operator:

1 Choose Assign to Users under
ChemStore's Administration/

Settings.
2 Select the Report Template tab,

see figure 26.
3 Select Operator from the user

drop-down list, see figure 27.
4 Select the report template

Compound Reports… and click
the right arrow in the middle of
the menu, see figure 26.

5 Close the menu and log on as
user operator (Administration/

Change User) with the password
operator. Click the report 
template icon and make sure
that the list includes the
Compound Amounts Report

user1 as shown in figure 28.

Printing reports
Reports can be displayed on the
screen (Print Preview), printed
on the printer, or saved to a file
for easy data export. The report
destination – Screen, Printer, File –
is selected with the reporting
smart icons or set in the report
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Figure 28
Check that user operator has access to the custom compound amounts report

Figure 29
Report printout options, showing the drop-down list, print preview and print icons (far right)

menu as shown in figure 29.
Available file formats are .CSV,
.HTML or .XML. To print a report,
do the following:

1 Select the data you want 
to use as described in section
“Selection of data files for
reporting – querying the 
database”. 

2 Select the report template from
the drop-down list

3 Select the print destination.

Note that ChemStore reports can
also print automatically at the end
of a ChemStation sequence as
described in section “Setting up
ChemStore”. This report allows
for direct file export and printout
but it does not offer print preview.   

Conclusion
ChemStation Plus opens up a new
dimension of reporting possibilities.

Although perfectly adequate for
certain requirements, reporting
with the ChemStation base soft-
ware is limited to chromatographic
data and associated results (such
as plate number and resolution 
of peaks in a chromatogram) for
predefined sequence-based sample
sets. Reporting with ChemStation
Plus, also referred to as ChemStore
database reporting, offers in 
addition non-chromatographic
sample data in custom fields (such
as batch number and sample source
information) and result meta data
(such as approval and archive 
status with audit-trail information).
It also enhances ChemStation
base software reporting with
query-based, cross-sequence,
cross-instrument, cross-operator
sample selection for reports. 

ChemStore database reporting is a
powerful tool for customized report

configuration and supplements
the easy and quick reporting 
possibilities of ChemStation base
software. It allows the user to
combine information across
sequences and instrumentation
in a single report. ChemStore
reporting is designed to create the
final analytical result as a paper
copy. This result includes meta
results such as trend charts and
statistical summaries as well as
all raw and meta data that might be
required in an audit situation. This
functionality helps users to get
results faster without sacrificing
compliance or completeness.
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Appendix
Sequence Summary report on ChemStation Plus

Page 1 of 5
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Page 2 of 5

Sequence Summary report on ChemStation Plus (continued)
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Page 3 of 5

Sequence Summary report on ChemStation Plus (continued)
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Page 4 of 5

Sequence Summary report on ChemStation Plus (continued)
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Page 5 of 5

Sequence Summary report on ChemStation Plus (continued)
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Page 1 of 2

System Suitability Report
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System Suitability Report (continued)

Page 2 of 2
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Page 1 of 2

Sample Summary Report

Sample Summary Report

Report Last Modified: 20-Jan-00 13:08 Current Operator agratz

Data Selection Criteria

Query

Name: <untitled> (agratz)
Run Selection: Only latest runs
Conditions: Sample Processing Parameters.Sample Type IN 

(´Calibration´, ´Sample´, ´Seq)

Standard Filter

Approval Status: No Filter
Archive Status: No Filter
Reprocessing Status: All

User Filter

Condition: None

Template

Compounds: Only calibrated compounds
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Sample Summary Report (continued)

Page 2 of 2

Sample Summary Report
Study Name: Systsuitability Instrument Name: Instrument 1

DA-Method: SYSSUIP.M

Sample Run Table

Sample Name Injection Time Data File Smp.Type Smp. Amount

Data Path: L:\DATA\SYSSUI\
calanti+ 11-Feb-02 8:30 CON00001.D Calibration 0.00
calanti+ 11-Feb-02 8:39 CON00002.D Calibration 0.00
calanti+ 11-Feb-02 8:48 CON00003.D Calibration 0.00
calanti+ 11-Feb-02 8:57 CON00004.D Calibration 0.00
calanti+ 11-Feb-02 9:06 CON00005.D Calibration 0.00
urine mueller 11-Feb-02 9:15 CON00006.D Sample 0.00
urine mueller 11-Feb-02 9:24 CON00007.D Sample 0.00
urine mueller 11-Feb-02 9:33 CON00008.D Sample 0.00
antiprrine+ 11-Feb-02 9:51 CON00010.D Seq Control 0.00
antiprrine+ 11-Feb-02 10:01 CON00011.D Seq Control 0.00
urine Kaiser 11-Feb-02 10:10 CON00012.D Sample 0.00
urine Kaiser 11-Feb-02 10:19 CON00013.D Sample 0.00
urine Kaiser 11-Feb-02 10:28 CON00014.D Sample 0.00
calanti+ 11-Feb-02 10:37 CON00015.D Calibration 0.00
calanti+ 11-Feb-02 10:46 CON00016.D Calibration 0.00
calanti+ 11-Feb-02 10:55 CON00017.D Calibration 0.00
calanti+ 11-Feb-02 11:04 CON00018.D Calibration 0.00
calanti+ 11-Feb-02 11:13 CON00019.D Calibration 0.00
urine Kline 11-Feb-02 11:22 CON00020.D Sample 0.00
urine Kline 11-Feb-02 11:31 CON00021.D Sample 0.00
antipyrine+ 11-Feb-02 11:40 CON00022.D Seq Control 0.00
antipyrine+ 11-Feb-02 11:49 CON00023.D Seq Control 0.00
antipyrine+ 11-Feb-02 11:58 CON00024.D Seq Control 0.00
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